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CREATURES
FROM FOLKLORE

SIMON DOMINIC BREWER SHARES HIS TROLL CREATION WITH US.
Portraiture

Nykolai Aleksander will be continuing our portraiture series showing us
how to paint a portrait of a female.

NEW!!! Art Fundamentals

loan Dumitrescu kicks off our new Art Fundamentals Tutorial Series
looking into Composition.

NEW!!! Photoreal Fantasy

Darren Yeow this month brings us chapter 1 of our new Photoreal
Fantasy Tutorial Series with his Griffin image creation.
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Editorial

Hello and welcome to 2011! | hope you all
had a great Christmas and New Year. | hope
2011 is a successful and creative year for

all of you. | look forward to seeing all of your
images throughout this year. If you haven't

submitted work for the 2dartist galleries before

please do so by emailing your images to me

at simon@3dtotal.com. You never know, this could be your lucky year.

Ok, so on to the good stuff. You thought the season for being treated
was over, but you were mistaken, we have a huge amount in store for
you this month so let’s start with the tutorials. There are some things
that just can’t be ignored and cheated when creating great art work, and
we call these the art fundamentals. This month see’s the birth of our
new series which covers the vital subjects that when mastered can turn
you into a great artist. Our new series Art Fundamentals will be handled
by seasoned pro’s starting with loan Dumitrescu who will be teaching us

about composition in this issue.

There isn’t just one new series starting this month though as Darren
Yeow will be kicking off our new set of tutorials about painting real
looking fantasy creatures. In our new series named Photoreal Fantasy
the artists will be trying to show how to design and paint fantasy
creatures to look real using any method they choose. This month Darren

will be showing us how to paint a Griffin.

Portrait pro Nykolai Aleksander will be continuing our portraiture series
showing us how to paint a portrait of a female. If anyone knows about
painting portraits it's Nykolai and she doesn’t disappoint in this tutorial.
Also continuing this month is our fantastic Painting Creatures form
Folklore series, and again we call upon a master in the subject as
Simon Dominic Brewer fantasy king shows us how to design and paint
a Troll. | was lucky enough to spend the day with Nykolai and Simon
recently as they helped out with judging for Digital Art Masters, and |

can tell you these are super talented!

Every now and again it is nice to see some light hearted cartoon digital
art, and we have that for you in our Making Of this month. Rafael
Nascimento shows us how he painted his outstanding image Closet
Monster.

This month’s Sketchbook is a more classical affair. Marta Nael shares
her sketches with us and tells us how important it is to have knowledge
of anatomy and form. Marta also shows us some of her fantastic digital
work and shows how she combines the classical impressionist style with

modern digital tools.
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Nicolas Ferrand is the subject of this month’s interview. Nicolas uses
some really interesting methods to create his images, including some
heavy usage of 3D. Nicolas has a style that stands out and | know that

you will love browsing the images he has sent us to accompany his text.

Finally there is the gallery which as always gives us a glimpse into the
abundance of skill out there today, and in this issue we have work from
Alex Popescu, Branko Bistrovic, Steve Jung, Andreas Rocha and many

more.
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Piracy Notice
3DTotal.com Partnering With ConceptArt.org

3DTotal is glad to announce that the successful anti-piracy
system used on ConceptArt.Org to protectiit’s video content
is now being used to bring an end to piracy of the content
produced by the incredible artists who support our magazines,
website and tutorials which are enjoyed by so many. This
anti-piracy effort has brought to light many of the users
who have been pirating content illegally in the ConceptArt.
org community and it is now assisting with protecting and
enforcing copyrights here.

3DTotal greatly appreciates all our customers and the
incredible artists who support this community with products.
Piracy has become a major obstacle that must be resolved in
order to see the artists who create these works and 3DTotal see
success long into the future. Without the content sold here,
this community and resource would not be what it is. With the
support of our customers we have been able to offer an ever
increasing stable of great content at affordable prices. Thank
you all for your continued support. We are here to help teach
and assist artists worldwide.
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Contributing Artists

Every month many artists around the world contribute to 3DCreative and
2DArtist magazines. Here you can find out a bit more about them!
If you would like to be a part of 3DCreative or 2DArtist magazine, please

contact: simon@3dtotal.com

(0

[\

Nicolas
Ferrand

Nicolas Ferrand (viag) has been
an active concept designer in

the gaming industry since 1999.

Born in France in 1975, he now
lives in Montreal Canada. He has contributed to the
development of several AAA released games: Like
Assassins Creed, Splinter Cell and Prince of Persia.
Currently he’s working on THIEF 4 at Eidos/square

Enix Montreal.

http://lwww.redwhirlpool.com/

viag@msn.com

Marta
Nael

From a young age Marta
showed extraordinary aptitudes

regarding drawing and painting.

It soon became apparent to her
what she wanted to become. Marta has a love for all
artistic disciplines but after completing her Fine Arts
degree she discovered her passion: matte painting
and concept art. Digital art has enabled Marta to

be self-employed and embark herself in a variety of
projects.

http://martanael.daportfolio.com

martanael@gmail.com

Ioan
Dumitrescu

loan Dumitrescu is a
architecture student and a

self-taught concept designer.

He loves drawing the things he
imagines in his head and trying to convey a story
to the viewer through them. He is currently working

freelance.

http://jonone.cgsociety.org/gallery

jononespo@yahoo.com
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N{kolai

Aleksander

A UK-based freelance character
illustrator and portrait painter,

she’s been working in the CG

field for the past eight years,
with publications in several Ballistic Publishing books
and 3Dtotal’s ‘Digital Art Masters’ series, as well as

numerous magazines around the world.

http://www.admemento.com

x@admemento.com

simon
Dominic Brewer

Simon is a freelance illustrator
specializing in fantasy, sci-fi,

horror and the generally bizarre.

He paints digitally, applying
traditional techniques through use of digital tools. He
has worked on game art, book covers, editorial and

magazine workshops since going pro in 2009.

http://www.painterly.co.uk

si@painterly.co.uk

Darren
Yeow

A 28-year old self-taught
illustrator, originally hailing from

Adelaide, who has worked as

a concept artist, user interface
designer and art director in video game companies
for the past 5 years, and currently lives in Melbourne.
He now runs his own studio ‘Stylus Monkey Design’
outsourcing concept art to the games industry,

undertaking freelancer illustration projects.

http://stylusmonkey.carbonmade.com

darren@stylus-monkey.com

Would You Like To Coniribute To
3DCreative Or 2DArtist Magazines?

We are always looking for tutorial artists, gallery submissions, potential
interviewees, ‘making of’ writers, and more. For more information, please

send a link to your work to: simon@3dtotal.com

wiw.2dartistmag.com Issue 061 January 2011
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Sefting up your PDF reader

For optimum viewing of the magazine it is recommended that you have
the latest Acrobat Reader installed.

You can download it for free here: DOWNLOAD!

To view the many double-page spreads featured in 2DArtist magazine,
you can set the reader to display ‘two-up’, which will show double-

page spreads as one large landscape image:

1. Open the magazine in Reader;

2. Go to the View menu, then Pﬂgﬂ (liSlllﬂY
3. Select TWO-llll Cﬂlllillllﬂlls making sure that Sllﬂw COVBI’
Pﬂge is also selected.

Get the most out of your

Magazine!

If you're having problems viewing the double-page spreads that we
feature in this magazine, follow this handy little guide on how to set

up your PDF reader!


http://www.adobe.com/products/acrobat/readstep2.html
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“A concept artist is a
concept artist whether you
work with clay, 3D, paper
or wood sticks. As long as

youl come up with cool,
iresh ideas, the medium
doesn’t matter.”
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Match-moving,
Set Reconstruction,
and Stabilization

SynthEyes 2011

i nd
. ure Extraction a
Now |ﬁ\‘:yitli'lcaa‘th:_\}az“9 TeXterEffectS exporter!
Sop 1S

See the tutorial at http://www.youtube.com/SynthEyesHQ

Pro 64-bit version only $599 for Windows and Mac OS X,
full-featured entry-level 32-bit version an incredible value at $399

‘% Typical Applications !J What Our Users Say About SynthEyes 2011

B Fixing Shaky Shots “I've been faffing about with the texture extraction

tool and it's brilliant!”
m Virtual Set Extensions )
“Has to be seen to be believed!”

B Animated Character Insertion

“You've got a great product at an incredible price.”

m Product Placement
in Post-Production “Texture extraction in Syntheyes 2011 is awesome.
It works so well it must be magic.”

B Face & Body Motion Capture
“I love the tracker radar!

E Talking Animals It's useful AND it looks cool.”

Andersson Technologies LLC

ssontech.com

Seventh year in the market, serving artists in over 70 countries


http://www.ssontech.com
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Solutions for Your Digital Nature
www.e-onsoftware.com
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“I believe that
skefches can be seen
as finished artwork,
since sometimes it’s
more interesting

(o keep a drawing
rough and unfinished
than continuing to
work onit. ”

This month’s sketchbook bridges the gap between tradition and concept art. Marta Nael
shares some of her sketches and WIP images with us and shows a great way to use
colors in our sketches. We also get an insight into how Marta mixes digital painting with

a tradition style.









Fig.03 — 04 are five minute sketches done
on A4 paper with charcoal. When drawing an
entire model in about five minutes, you have
to rush to capture the mood, atmosphere
and light rather than spending time on the
details. This helps you discern between
important and less important features;
something which is useful when working on
the finished illustration as it prevents you
from getting lost in the early stages of the
creative process, or getting caught up in the

details.



In Fig.05 — 06 you can see how I tried to push the techniques mentioned before to the limit, and avoided
defining the model as much as possible. These sketches were just studies of color and mood, and that's
why | wanted to use vividly colored paper, which in my opinion is a real challenge for any artist, and an

exercise that can really help you improve in the area of light and color.

Doing this helps you learn to see the reality of “over-saturated”
colors, and it's this type of visualization which, when
applied, results in truly colorful sketches with dynamic
lighting. For example, if you have a gray surface
there’s always the possibility of interpreting it as

a “blue-gray” or as a “red-gray”, which in turn will

make you decide which direction you want to go

and paint in, with a light blue or a light red rather

than a plain and boring shade of gray.

| believe that sketches can be seen as
finished artwork, since sometimes it's more
interesting to keep a drawing rough and
unfinished than continuing to work on
it. If you do continue, you can lose
the fresh and spontaneous look

or the painterly feel of it.






In Fig.07 you can see a 100x70cm sketch in pastel, which
took 20 minutes, where | followed the same steps as in

Fig.05 — 06.

Nowadays I've moved over to digital, but pencil sketches
are still an important part of my work. You can see some
examples in Fig.08 — 12. In these my aim was not to
improvise, but to explore details and practice fantasy
subjects, mainly because | don’t usually do sketches to plan
illustrations. In fact, | usually leave sketches as they are as |

tend to see them as finished pieces.






In part this is because, as | said before, | don't feel comfortable with
having line work which | then have to apply color to. In any case, | would
only consider applying color to a sketch if it inspired me to create a
realistic illustration from it. This wouldn’t be the case for my usual more
impressionistic digital illustrations, as the detail involved in my sketching
would distract me, and would make it difficult to preserve the freshness

and painterly feel that | always strive to achieve.

Keeping that “unfinished” look is something
which | keep in mind when doing my digital
impressionism series. At school and university
| was always told my work could be described
as a “game of light and color”. Maybe | fell in
love with impressionism because of that, since
it seemed it was really similar to what | enjoyed

doing in my traditional work.






Ay

Here | just followed the same steps as in those
watercolor sketches shown before. | filled the
whole canvas with a flat color (Fig.13) and then
| start defining surfaces by adding more color
(Fig.14 — 15). At this point, the composition,
light and mood you create will very likely stay
with you until the end, so you must pay special
attention to it. Once I'd captured it in rough, |
then began to paint it to look like the reference
image (Fig.16). | tried to make it look as similar
as possible, but always with vivid colors and

brave long strokes. At this stage | avoided

adding border lines; | just added some at the
end to clearly separate the character from the
background, and | also tended to add some
lines to the background around the character to

improve its contrast and definition.

MARTA NAEL

For more information please visit:
http://martanael.daportfolio.com
Or contact them at:

martanael@gmail.com

Sketchbook
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Dragon Summoner

Koryo Warrior
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The Awakening


http://alexpopescu.net
mailto:aksu00@gmail.com

Someone Hug This Witch
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Sranded

Peter Oedekoven
http://www.oedekoven-illustration.com

peter@die-artillerie.de
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Monkey King

Songnan Li
http://blog.sina.com.cn/oldmole

wuminggege0202@yahoo.com.cn
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Playtime

Salvador Ramirez Madriz
http://reevolver.deviantart.com/

chava_art@hotmail.com
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© Salvador Ramirez



Main Panel

David Munoz Velazquez
http://www.munozvelazquez.com/

munozvelazquez@gmail.com
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VFS ANIMATION & VISUAL EFFECTS ALUMNI CREDITS INCLUDE 9 Mike Dharney, Animator 2012 Jamie Bowers,

Texture Artist | Zeke Norton, Previsualization Supervisor | Anuj Patil, Senior Technical Director | Christine Peterson,

Digital Compositor 50 Cent: Blood on the Sand (VG) Giorgio Bertolone, Creature Technical Director Aliens in the

Attic Rex Ahn, Pre-Visualization Lead | Craig Calvert, CG Supervisor | Julianna Kolakis, Character Designer | Ben

Sanders, Supervising Animator | Rommel Shamoun, Compositor | Noel Wright, Digital Compositor | Adam Yaniv,

Animation Supervisor Alvin & the Chipmunks: The Squeakuel Nicholas Augello, Technical Animator | Christopher

Downs, Technical Animator | Amy Lu, Animator | Adam Yaniv, Animation Supervisor Amelia Armando Velazquez,

Digital Compositor | Clement Yip, Animator America's Army 3 (VG) Matthew Turner, Artist Angels & Demons Craig

Calvert, Pre-Visualization Artist | Jessica Wan, Lead Rotoscope Artist | Noel Wright, Digital Compositor Armored Riley

Benard, Digital Compositor | Yuta Shimizu, Visual Effects Artist Astro Boy Andreas Hikel, Layout Artist | Kim Ooi,

Animation Director Avatar Michael Cozens, Lead Animator | Tamir Diab, Technical Director | Aaron Gilman, Character

Animator | Alfredo Luzardo, Layout Technical Director | Ben Sanders, Animator The Beatles: Rock Band (VG) Mike

Krentz, Ul Artist Briital Legend (VG) Marke Pedersen, Senior Artist Case 39 Riley Benard, Digital Compositor | Craig

Calvert, CG Supervisor | Matthias Lowry, Visual Effects | Fion Mok, Matchmove Artist | Teh-wei Yeh, Matchmove Artist

Cirque du Freak: The Vampire's Assistant Nicholas Augello, Technical Animator | Julianna Kolakis, Character

Designer | Ai Saimoto, Lighting Lead Cloudy with a Chance of Meatballs Andrew Lawson, Animator | Arun Ram-Mohan,

Senior Color and Lighting Technical Director Coraline Brian Demoskoff, Animator A Christmas Carol Kirk Chantraine,

Motion Capture Technical Director | Joel Pennington, Motion Capture Technical Director | Shraga Weiss, Character Modeler

Brent Wong, Character Modeler District 9 Neill Blomkamp, Director/Co-Writer | Jelmer Boskma, Modeler | Robert Bourgeault,

Lighting Lead | Freddy Chavez, Visual Effects Compositor | Dominic Cheung, Lighting Technical Director | Paul Copeland,

Visual Effects Artist | Anthony Di Ninno, Animator | Brian Harder, Creature Rigger | Bernhard Huber, Effects Animator | Brett

Ineson, Motion Capture Supervisor | Steve Johnston, Render Wrangler | Patrick Kalyn, Animator | Bernhard Kimbacher, Visual

Effects Data Coordinator/Compositor | Julianna Kolakis, Creature Texture Painter | Adam Marisett, Visual Effects Artist | Nikolai

Michaleski, Compositor | Brendon Morfitt, Digital Artist | Fernando Pazos, Animator | Dan Prentice, Visual Effects Artist | Mike

Rhone, Visual Effects Artist | Cesar Rodriguez Bautista, Digital Paint & Roto Artist | Cynthia Rodriguez del Castillo, Digital Paint

& Roto Artist | Marc Roth, Visual Effects Artist | Derek Stevenson, Matchmove Lead | James Stewart, Creature Supervisor | Richard

Sur, Lighting Technical Director | Anna Tonrungroj, Digital Compositor | Shawn Walsh, Visual Effects Executive Producer | Joey

Wilson, Modeler/Texturer | Samson Wong, Matchmove Artist Drag Me To Hell Thomas Schelesny, Visual Effects Supervisor

Dragon Age: Origins (VG) Bobby Bath, Character/Creature Artist | Ryan Lim, Lead Creature Character Artist | Herbert Lowis,

Artist | Brian Sum, Concept Artist | Nathan Zufelt, Cinematic Animator Escape from Planet Earth Giorgio Bertolone, Creature

Technical Director | Anthony Di Ninno, Layout Artist | Craig George, Head of Story | Gary Hendry, Layout Artist | Nicholas Smolyn,

Layout Artist Eureka Anuj Patil, Lead Compositor | Mike Rhone, Visual Effects Artist Fast & Furious Ben Dishart, Texture Artist

Armando Velazquez, Digital Compositor The Final Destination David Yabu, Animator G-Force John Iskandar, Lighting and Compositing

TD | Ken Kaiser, Animator | Hyun Chul Jung, Animator | Andrew Lawson, Animator | Phan Wiantrakoon, Animator Ghostbusters: The Video

Game (VG) Giorgio Bertolone, Creature Technical Director | Winston Fan, Compositor | Harry Liu, Junior Motion Capture Editor | Jessica Mih,
Modeler | Maya Zuckerman, Visual Effects Artist Gl Joe: The Rise of Cobra Jelmer Boskma, Modeler | Patrick Conaty, Digital Compositor | Ben
Dishart, Texture Supervisor | Aruna Inversin, Digital Compositor | Julianna Kolakis, Concept Artist/Modeler | Sean Lewkiw, Visual Effects Artist | Tom
Piedmont, Digital Artist | Jeremy Stewart, Senior Animator | Jeff Tetzlaff, Lead Modeler | Jessica Wan, Lead Rotoscope Artist Grey Gardens Armando
Velazquez, Digital Compositor Halo 3: ODST (VG) Bartek Kujbida, Cinematic Animator Harper's Island Steve ). McLeod, Digital Compositor Harry
Potter and the Half-Blood Prince Harry Mukhopadhyay, Lead Effects Technical Director | Pietro Ponti, TD Generalist | Gia Sadhwani, Digital Effects
Artist | Kieran Tether, Digital Artist | Teh-wei Yeh, Lighting TD Ice Age: Dawn of the Dinosaurs Scott Lemmer, Animator | Thom Roberts, Animator | Brent
Wong, Modeler Invictus Christopher Ahrens, Lighting Lead | Geoffrey Hancock, Visual Effects Supervisor | Sean Lewkiw, Digital Effects Supervisor | Jason
McKeeman, Lead Technical Animator | Farhad Mohasseb, Compositor | Michelle Skrzyniarz, Matchmove Artist | Jose Yapor, Animator Killzone 2 (VG)
Andrea Arghinenti, Technical Artist King of the Hill Michael Loya, Director Knowing Tim Rowlandson, Rigging Technical Director | Richard Sur,
Lighting Technical Director Land of the Lost Nicholas Augello, Massive Technical Director | Tony Etienne, Lighting Supervisor | Amy Lu, Character
Animator Law Abiding Citizen Freddy Chavez, Compositor | Veronica Marino, Compositor | James McPhail, Effects Animator | Jacob Curtis Miller,
Matchmover | Jay Randall, Visual Effects Supervisor | Derek Stevenson, Matchmover | Shawn Walsh, Visual Effects Executive Producer The
League of Super Evil Daphne De Jesus, Compositor | Barry Karnowski, Animation Supervisor The Lord of the Rings: Conquest (VG)
Michelle Lam, Lead Character Artist The Lovely Bones Michael Cozens, Previs Animator Monsters vs. Aliens Jiyoung Lee, Texture Artist

Night at the Museum: Battle of the Smithsonian Rex Ahn, Previsualization Lead | Nicholas Augello, Technical Animator | Christopher

Downs, Technical Animator | Joshua Herrig, Lead Lighter | Zeke Norton, Previsualization Supervisor | Ai Saimoto, Lighting Lead | Ben

Sanders, Supervising Animator | Derek Stevenson, Previsualization Artist | Joey Wilson, Previsualization Artist | Adam Yaniv, Animation
Supervisor Orphan Francisco Moncayo Moreno, Digital Artist | Shawn Walsh, Visual Effects Executive Producer Paul Blart: Mall Cop

Riley Benard, Digital Compositor Planet 51 Sandro di Segni, Senior Effects TD | Jorge Kirschner Torres, Modeler | Gianfranco Valle, Effects

Animator Prototype (VG) Harry Ahn, Lead Cinematics Animator | Bobby Bath, Lead Character Artist Punch-Out!! (VG) Nelson Garcia,

Concept Artist Pushing Daisies Scott Dewis, Visual Effects Red Faction: Guerrilla (VG) Dilber Mann, Project Manager Resident Evil 5

(VG) Jacob Palmer, Animator Rock Band Unplugged (VG) Mike Krentz, Artist Sanctuary Julie Bergman, Animator | Mladen Miholjcic,

Visual Effects Artist Shorts David Yabu, Animator Sorority Row Mike Rhone, Visual Effects Artist Star Trek Aruna Inversin, Digital
Compositor | Tom Piedmont, Digital Plate Restoration | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist Stargate Universe

Daphne De Jesus, Digital Compositor | Julianna Kolakis, Character Designer | Daniel Osaki, Lead 3D Modeler | Anna Tonrungroj, Digital
Compositor Supernatural, Daphne De Jesus, Digital Compositor Surrogates Anthony Di Ninno, Animator | Joshua Herrig, Lighting
Artist/Look Dev Artist | Matthias Lowry, Digital Compositor | Laurie Powers, Compositor | Teh-wei Yeh, Digital Artist Tales of Monkey

Island (VG) Jason Findley, Character Artist Terminator Salvation Geeta Basantani, Digital Matte Painter | Teh-wei Yeh, Lighting

Technical Director Transformers: Revenge of the Fallen Allen Holbrook, Animator | Aruna Inversin, Compositor | Stephen King,

Animator | Henri Tan, Creature Technical Director | Kieran Tether, Digital Artist | Teh-wei Yeh, Digital Artist The Twilight Saga:

New Moon Dominic Cheung, Lighting Technical Director Uncharted 2: Among Thieves (VG) Mike Yosh, Lead Animator

Underworld: Rise of the Lycans Pearl Hsu, 3D Artist | Lon Molnar, Visual Effects Production Executive Up Bill Watral, Visual
Effects Artist Warhammer 40,000: Dawn of War Il (VG) lan Cumming, Senior Artist | Allan Dilks, Artist | Nathan Hocken, Lead
Animator | Christine Hubbard, Artist | Claire Roberts, Artist | Jefferson Takahashi, Artist Watchmen Ori Ben-Shabat, Compositor
Jelmer Boskma, Previs Modeler | Freddy Chavez, Compositor | Dominic Cheung, 3D Artist | Ben Dishart, Texture Artist | Ty Duperron,
Modeler | Pearl Hsu, 3D Artist | Bernhard Kimbacher, Digital Artist | Sean Lewkiw, Technical Head of 3D | Matthias Lowry, Digital
Compositor | James McPhail, Digital Effects Artist | Jacob Curtis Miller, Digital Artist | Lon Molnar, Visual Effects Supervisor | Harry
Mukhopadhyay, Lead Effects TD | Cynthia Rodriguez del Castillo, Digital Artist | Derek Stevenson, Matchmove Artist | Shawn Walsh, Visual
Effects Supervisor | Samson Wong, Compositor Wheelman (VG) Laura Gorrie, Senior Animator Whiteout Armando Velazquez, Digital
Compositor | Clement Yip, Animator Wolfenstein (VG) Jason Martin, Modeler X-Men Origins: Wolverine Geeta Basantani, Digital Matte

Painter | Rommel Shamoun, Compositor | Jeremy Stewart, Previs Artist Zombieland Mike Rhone, Visual Effects Artist to name a few
VFS student work by Thiago Martins


http://vfs.com/3dcreative
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Chapter 02 | Next Issue

Chapter 03 | March Issue 063
Chapter 04 | April Issue 064

Chapter 05 | May Issue 065
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Art Fundamentals Article:
Chapter 01 - Composition

Software used: Photoshop

Composition is the first word on the best

artists’ lips when they start an image. But

what is composition? It's basically the layout

of elements and a visual vocabulary that

leads your eyes around an image and makes

it interesting. It’s the first crucial step in

making your image interesting from the get

go. No detail, fancy colors, lighting or action

will substitute composition. Even though
composition theory has rules that have been
used for hundreds of years, you can always
find new and interesting ways to apply them to
your compositions. Try to think outside of the
box. I'm going to take you through a quick guide
into composition and see where it leads us, and

what we discover along the way.

The Ancient Greeks used the golden rectangle
that had divine proportions .The golden
rectangle is a rectangle that has sides which
are approximately at a ratio of 1:1.618. By using
these proportions you get a very balanced and
pleasing composition, with a strong focal point.
The divine proportions appear in many life

forms, including humans (Fig.01).

Derived from the golden rectangle is the Rule of
Thirds, which was adapted to cope with a wider
range of aspect ratios. By dividing you frame
into three equal parts from each side you create
four power points where the lines intersect each
other (Fig.02). For example, the image “Under A
Rock” uses the principles of the rule of thirds, by

having the converging lines create focal points.

www.2dartistmag.com
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You can see the main focal point is the building
(A). Then | added secondary focus points

near the converging lines: the windmill farm

in the far background (D) and the actual rock
structure, which has a great deal of importance
in the concept and which runs along two other

intersections (B and C).

If you have a vertical frame, the rule of thirds
can also be applied. In the image “Queen of
Candasce” | placed the flying ship very close to

the converging line (Fig.03).

Your main focal point should not always be
on the intersection of the power lines. When
considering your composition remember that

contrast is important. It helps you to make areas
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stand out even though they may not be near a

power point.

Contrast can be achieved in many ways. The
easiest is light and dark, followed by material
contrast, contrast of hue or saturation, tension or
balance and contrast of shapes, round or square
etc. In Fig.03 | kept the ship and huge structure
close to the power points because, from a story
standpoint, it was very important to show the
direct connection between them. Then for the
lower power points | left the environment where

the action takes place.

Another easy trick | used in this image, which
can be used for any aspect ratio, is provide

a big foreground. Because we are used to
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reading from left to right, this pulls the viewer in
and leads the eye more easily into the image

providing a grounding point for the whole frame.

This leads to another simple composition trick,
which can result in very beautiful images and
that is very commonly used on book covers
(Fig.04). It's based on having a frame for your
image - in this case a big L - that leaves the
rest of the image in focus and easy to see. It's
a great and easy way to make things stand out

and can help give monumentality to your image.

When using this rule, make sure you don't fall
into a trap and follow it exactly. This can make
your images boring and dull. Keep to the grid at
first, but get rid of it as soon as possible so you

don’t start to repeat a few generic compositions.

In composition even a small change can have

a great effect on the final image. Changes

such as tilting your horizon line are a great way
of making your image look more dynamic. In
Fig.05 — 06 the story was all about suspense,
thrills and action. So tilting the horizon made

all the difference; it adds more narrative to the
image and depicts drama and action, which gets

different reactions from the viewer.

www.2dartistmag.com
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Simple compositions can sometimes be the

most effective. Sometimes less is more (Fig.07).
For example you can use your perspective to
lead the viewer into the picture and directly to
your focal point. Now the power lines are your
perspective lines. Use whatever objects you
have in your scene to point at the focal point.
You can also use a technique used in films,
paintings and photography vignetting, which is
basically darkening the edges and corners of
your image so that the eye doesn’t escape. It's
very effective when dealing with quick sketches

among other things.

Another quick and effective composition

technique is basically having your image layout @

follow certain shapes, like a circle, cross, square, triangle, oval etc. By
repeating those shapes to create a rhythm and a hierarchy in your image,
it holds your eye inside those shapes and leads it more directly to a payoff

spot.

In Fig.08 | used ovals to create a spiraling effect leading to the train, which
is the focal point of the image, but | made sure | included the train stop as
well. It made the image more dynamic and gave a sense of movement to

the train.

For Fig.09 | used a composition technique that is very common in the
work of Frank Frazetta and that is basically a cross, with the hero on top of
a pile. Placing the camera so it is looking up at the victorious heroes helps
to convey the story better. Even though the composition might seem split
by the wreckage between them, it's because this was part of the story - to

show tension between them.

This was actually a tutorial for 2DArtist, using a 3D base to paint
over. Here | used a combination of the implied shapes, triangles and
perspective. They keep the eye flowing along their edges very nicely until

the payoff spot at the end of the hangar (Fig.10).

) o
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This image uses radial power lines converging
to one point, which makes the image menacing
and intimidating (Fig.11). For storytelling
purposes | brought in a circle shape, which
becomes the second read and contrasts

the hard edges of the huge structure in the

background.

These are a few of the rules of composition.
Don't be afraid to change them. For me,
composition is something very organic and

with practice it becomes more intuitive. As a
self-taught artist | use my intuition and natural
observations, and bring them into my work. |
start my images with basic principles like having
my image framed, having objects point at my
focal point and using contrast for the payoffs,
and along the way | gather a few more tricks
and methods that make me want to explore
composition beyond the usual rules. I'm not a
good rule follower so, at the moment, I'm trying
to give my compositions a continuous flow, and
lead the eye throughout the image, in a guided
tour if you wish, to discover light, color, details,
action and loads of personal elements that | put

into my images (Fig.12 — 13).

| hope you have enjoyed reading this.

Ioan Dumitrescu

For more information please visit:
http://jonone.cgsociety.org/gallery/
Or contact them at:

jononespo@yahoo.com
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“Portraits like these
are fun to do, hecause
you can fake them

as iar as you want to
take them, change
everything or nothing
atall.”
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Chapter 03 | Female | Nykolai Aleksander
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Portraiture - Chapter 03:
Female

Software used:

Eyehalling

Tracing

Let’s Paint! The Grid
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No Sketch

Click here to watch this movie
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For the lashes | add a new layer, as that gives

me more freedom to erase bits and soften them
as needed with the Smudge tool. And don’t be
scared of stray lashes! They add realism to the
whole. Once happy with it all, | merge the layers

with the portrait layer (Fig.11b).

Time to move on to the lips and nose now. They
don’t need that much refining, but I've noticed

a few flaws that | want to iron out. You'd be
surprised how some small details really change
the look of a person (or their expression, for that
matter), so paying close attention to this can be

very beneficial.

In this case, | just work a bit more on the texture

and volume of the lips, still using the Round

brush as before (Fig.12a — 12b).

Happy with the face for now, | review the
general composition and decide that she
needs more space, namely to the right. And
| do like the fact that the shoulder is cut off in

the reference on the left, so I'm going to do

the same. Grabbing the Crop tool, | am going . .
to kill two birds with one stone: cropping the will automatically only let you go as far as the want, in and outwards (Fig.13b). This process
part on the left, and extending the canvas to canvas edges (Fig.13a). Once you have that, saves you the time of having to use Image >

the right. When first applying the Crop tool, it you can adjust the crop on whichever side you Canvas Size in the main menu. The final crop
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Painting (reatures From
Folklore: Chapter 05 - Troll

Software used: ArtRage Studio Pro & Painter

One of the most recognizable characters in
folklore is the troll, yet ironically they come

in all shapes and sizes. Whilst some trolls

are depicted as huge and hulking, others are
described as being similar to normal folk,
distinguishable from humans only by their
clothing and habits. Troll tales originate primarily
from Scandinavia, although England and

Scotland also have a small troll tradition.

For this painting I've decided to paint a portrait
rather than an action scene, and to set it a forest
environment. A portrait approach will result in a
more formal character depiction, but will allow
for full focus on the character. My troll will be
an important personage in the troll community
and hence will be dressed more elaborately
than his peers. That doesn’t mean his clothing
will be pristine however, as the forest can be a
messy place and trolls aren’t renowned for their
cleanliness. In terms of weapons I’'m going to
give my troll a huge, oaken staff that doubles as
a club. Trolls tend to make use of the resources
around them so | think a basic, natural weapon
like a club is more fitting to a forest setting

than a sword or a magical item. To complete
this image I'll be using ArtRage Studio Pro and
Painter 11. I'll do the concepts and sketching

in ArtRage and move on to Painter for the
coloring and final detail. Either package would
be sufficient to complete the entire project,

but ArtRage’s strengths are in sketching, and

Painter’s strengths in detailing.

Quick Concepts

It's often a good idea to knock out some initial
sketches before beginning the main work. |
actually did this step before | made the decision

to create the forest troll portrait as | described.

For this piece | create half a dozen sketches,

each depicting a different type of troll (Fig.01).
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The process is very quick as these characters
are not intended for display, rather as a decision
aid and a catalyst for the creative process. | use

the default Pencil and canvas in ArtRage. | find

the rough feel closely mimics using a real pencil.

Using these concepts as a guide | choose the
third character as the one | want to develop.

With this in mind | move on to the actual image.

Line Work

My final image needs to be 2480x3425 pixels at
300dpi. However, because | won't be painting
fine detail until later on there’s no point working
with such a large canvas initially. Therefore

still in ArtRage, | create a small canvas with

the same aspect ratio as the spec for my final
image. | load my concept sketch as a reference
so | have a constant on-screen guide as to what

| want to achieve (Fig.02).

Next | create a new layer and draw a few rough

perspective lines to an imaginary vanishing
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point way off canvas to the left. My troll will be
large, maybe eight feet tall, and therefore | want
to give the impression that he is looming over
the viewer. Rendering the troll against these

perspective lines will help in this respect.

| make the outline sketch onto a new layer.
This stage is designed to give a basic, clean
indication of all the main elements of my
character. His clothing is composed of a rag-

tag combination of layered clothing, which will

have different textures in the final image. The
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skulls around his waist reinforce the idea that

he’s a big fella as well as an unpleasant one.
When I've finished the line drawing | hold Alt
+ H (Option + H on a Mac) to view the image
mirrored. This helps to identify any anatomical

or perspective problems.

Skeich Detall

| increase the size of my canvas to about half
the intended final dimensions. This will allow for
more detalil to be laid down. To compensate for
this | also increase my pencil Nib Size to around
200%. | reduce the Opacity of my line work layer
to 30% and create a third layer on top. Using
the low opacity line work as a guide, | create a

detailed sketch of my character (Fig.03).

Clean Up

The first two layers — the perspective lines

and the line work sketch — have served their

purpose, so | delete them. This leaves me with

the detailed sketch on a single layer (Fig.04). |
save this as a PSD file because the next time |

work on it I'll be using Painter.

Build a Color Palette

When painting, | find it very helpful to work from

a pre-created color palette — a Color Set. This

@ doesn’t mean I'll be choosing every single color
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from this palette, but it will act as the primary

selection tool.

To create the Color Set | first open a blank
canvas in Painter. As in the actual painting
stage it's a good idea not to use pure white as
the background as it can be overwhelming and
make it difficult to distinguish darker colors. |
use my Artists’ Oils brush to make a sequence
of splodges representing the main elements that
will be in my image — bright yellows for the sky;
deep browns, oranges and grays for clothing
material; mid-saturation, mid-valued pinks for
the skin tone and white for the hair. When I'm
happy that those colors will take care of most
of my requirements, | click the Create Color Set
From Mixer Palette option. This generates a
256-color Color Set palette, which | save as a
PCS file (Fig.05).
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Load the PSD into Painter

Because ArtRage processes paint in a different

manner to Painter, PSDs that have been
exported from ArtRage usually have a number
of extra layers. | load the PSD into Painter and
see that there are two blank layers and a paper
layer in addition to the canvas and sketch layer
(Fig.06). In this instance | remove both blank
layers and the paper layer, although if you prefer
the paper layer color to the canvas color you
may want to simply remove the two blank layers

and drop the paper layer to the canvas.

Underpainting
On the canvas | use my “Underpainting” Artists’

Oils brush to lay down a very quick, very rough

approximation of the colors I'll be using. This is

@ simply to act as a guide to the proper painting.

www.2dartistmag.com
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| choose a simple background, which acts as
an anchor for the character whilst providing a
hint of his natural environment. | will be painting
the background in low-contrast hues so that the

main figure stands out (Fig.07).

Upsize the Image

I’'m ready to begin the final painting process so

| upsize my image to its working dimensions
using Canvas > Resize (make sure Constrain
File Size is not ticked). | actually size it

to dimensions greater than the specified
2480x3425 pixels, so that | have more scope for
adding fine detail where needed. Because | am
careful to maintain the aspect ratio I'll be able

to resize to the exact specification when the

painting is complete (Fig.08).

Beginning Painiing

Before | start painting | drop the sketch layer

to the canvas so that the image is completely
flat (in terms of layers). | select the Artists’ Oils
brush and begin adding rough detail to the troll,
starting with the head and face. Because the
expression of the troll is important, | work using
a relatively small brush, about 10 pixels, with the
zoom set at 100% (Fig.09).
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Use the Largest Brush possibile

When painting larger areas, especially at this
stage, it's a good rule of thumb to use the
biggest brush possible. So instead of using
the 10-pixel width brush on the ogre’s exposed
arms, or flowing cloak, | increase the size to
15 or 20 pixels (Fig.10). Of course, as detail

increases, the size of the brush will decrease.

Using Lighting and Texture

Understanding the ways different materials react
to light is key to creating a believable image.
Here | combine a number of different materials
to form the troll’s garb, ranging from dull drapery
to the thick, calloused, fur-lined leather covering
his shoulders. | depict the leather as having
more surface variation of Hue, Saturation and

Value than the thin material of his robe, and also

j -

haintingitreatureskrongkolklore

slightly more Specularity (Fig.11). Even more
Specularity is present on his skin, on the skulls
around his waist, and also on the monstrous
staff he’s leaning on, as a result of the wood

being worn smooth over time.

o
Rough Background Detail

To finish off the rough detail work | move on
to the background. | increase my brush size
to around 30 pixels for this stage. In order to
depict bark on the tree | cross horizontal and

vertical bark textures so that the tree’s bulk is

evident in three dimensions and it doesn’t look
flat. By easing up on the pen pressure | can
blend certain areas so that the texture doesn’t
overpower the main character. | also darken the
area under the troll's feet. This is to anchor the
character with the background. If | didn’t do this
the character would look pasted and it would

flatten the image (Fig.12).

Painting Leaves

Selecting low saturation colors from my palette,

wwww.2dartistmag.com
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@ | dab at the ground plane, creating flecks that,
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from a distance, resemble leaves. I'll be refining

these shapes later on. At the moment it's
sufficient that these leafy shapes remind me of

leaves and are roughly the right color (Fig.13).

Using Colour Variability

I’'m about to begin the fine detail stage and this
involves using the Round brush. One neat trick
to improve the painterly appearance of detail is
to use the Color Variability settings. | select In
HSV from the pull-down (this stands for Hue,
Saturation, Value). | then set the sliders to H:
4%, S: 1%, V: 1%. This means that every time

I make a mark with the brush, the color hue

that I've chosen will change randomly within a
4% tolerance of my original color choice. In the
same way, the Saturation and Value will change
randomly within a 1% tolerance. It's a good

idea to play around with these settings to see
which suits you best (Fig.14). A word of warning
here. Painter 11 has a bug whereby these
settings can spontaneously reset to 0. For this
reason | keep the Color Variability panel on my

workspace and check it every so often.

Detailed Texiuring

With my small, Round brush set to between 5
and 12 pixels, | move over the character and
boost the detail level. Because our troll is a
forest dweller, and likely a bit of a thug too, | add
a few areas of scuffing, staining and dirt on his
clothes (Fig.15).

The Hands

The troll's hands, resting on top of his staff, are
an integral part of this piece, and they need to

look just right to make the piece believable. That

www.2dartistmag.com
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means particular attention needs to be paid to
the light and shadow, which, broadly speaking,

define the form (Fig.16). Here we can see the

@ troll's left hand is covering his right, which in turn
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is wrapped around the head of the staff. The
shadows are therefore placed to be consistent
with our light source. Where the fingers of

the right hand grip the wood | use a slightly
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desaturated highlight to simulate reflected light
from the environment. This helps to give solidity
to the hand. A light pressure on the pen will
blend paint on the canvas. | use this feature to

help stop the texture becoming too “scratchy”.

Resize the Skulls

| notice that the skulls on the left appear smaller
than they should, even taking in account the
slight perspective we have going on. | select
them roughly using the Polygonal Selection tool,
then hit CTRL / cmd C to copy the contents.

| remove the selection area using CTRL /

cmd - D and paste the skulls into a new layer
using CTRL / cmd - V. Using the Edit > Free
Transform menu option | enlarge the selection
object whilst holding down SHIFT to maintain
the aspect ratio (Fig.17). Lastly | choose Edit >
Transform > Commit Transformation and drop
the selection to the canvas. | also neaten the

edges a little so it blends with the image.

Robe Material

To paint the orange robe material | enlarge
the Round brush to between 10 and 20 pixels.
Varying the pen pressure is key in this painting
process. In the dark shadows | press quite

hard so the dark paint is applied “thickly” whilst

10i(reafureskronukolkIore

elsewhere I'll ease up on the pressure so that
the paint is more opaque and bleeds more

readily with existing colors (Fig.18).

When applying almost no pressure the brush
behaves more like a blender and helps to create
graduated yet textured blends between light
and shadow. To obtain a high degree of control
over your pen sensitivity you should experiment

with different settings in both your tablet settings

application and via your Edit > Preferences >

Brush Tracking menu option in Painter.

Scarred SKin

It's safe to assume this troll has had a hard
life, so the skin around his knees and shins
will be scarred and pockmarked (Fig.19). With
light brushstrokes | make a few dark lines and
dots on the skin. To make them appear etched

into the skin | make very faint highlights on the

o
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edges, especially the lower edges being that our
light source is above. As a general rule, if the
highlight is on the side of the blemish furthest
from the light source it appears like a groove;

if it's on the side nearest the light source it
appears like a bump, and of course vice-versa
for the shadow. Lastly, | add a bit of dark paint

to his knee to represent dirt and scuff marks.

Wood Texiure

If you're not careful the wood texture can easily
end up looking like skin or cloth. To avoid this |
use darker, more saturated colors for the wood
base color (Fig.20). | add desaturated specular
highlights sparingly to the staff to simulate old,
worn wood. Placing some of the bright highlights
directly onto the dark areas make it appear as

if the wood itself is dark, rather than in shadow.
This is a useful method of distinguishing dark
coloration from shadowed areas, especially on

shiny or slimy items.

Autumn Leaves

| use the Atrtists’ Oils brush to further define the
leaves on the ground. At this stage | concentrate
on getting the colors right and | leave the
shapes quite rough. | use a selection of lighter,
desaturated colors for the leaves themselves

and dab deep purples and black at their
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periphery, to suggest the shadow and dark earth
beneath (Fig.21).

Focus

When painting the leaves it's easy to get
caught up painting one leaf after another and
forget the overall image. If you're not careful

this can flatten the image due to each leaf

being basically the same value and saturation.
Zooming out from time to time helps you see
how your leaves are becoming part of the
scene. Here, | want the leaves in the immediate
foreground to be larger, brighter and more
colorful than those at the side of the troll,

or behind him (Fig.22). | also fade out the

leaves at the periphery of the piece, to create
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exaggerated focus on the main character. | don’t
use overlays or layers to achieve this effect,
rather choose the appropriate color for each leaf
and take advantage of the blending function of
the brush (Blend increases as Pen Pressure
decreases). | also want the troll to appear like
he’s standing on the ground, not floating in front
of it. For this | darken the area below him and
to his right, to simulate shadow. Again, | try and
pick the correct color from the palette or color
wheel rather than using layers. You'll see here
that I've also flipped the image, which | do from

time to time to check composition and anatomy.

Tree Bark

For the tree and the rest of the background

I'm careful to use only low saturation colors

of mid- to high-value. This is to give a sense

of depth and so they don’t compete with the
main character. Keeping it loose, and still
using the Artists’ Oils brush, | dab in darker
lines which run vertically up the tree trunk. At
irregular intervals | sketch small, rough arcs
perpendicular to these lines to give the subtle
appearance of bulk. This helps gives the trunk a
3D appearance and avoids the “stage set” look

(Fig.23).

Final Defail - Leaves

I’'m almost finished now so | move around the
painting adding some final detail with the Round
brush. | don’t want to refine the leaves too
much so | just spend a few minutes tweaking
the brush strokes into more leafy shapes. |
don't obsess over each leaf because it's more
important to suggest the impression of leaves
rather than to painstakingly render each one
(Fig.24). | also extend the length of the troll's

cloak a little, for aesthetic value if not modesty.

1oiCreanuresikronukolkiore
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Fnal Defail - Tree

Using the Round brush | refine some of the tree

detail — the fungus and area of discolored bark
especially. The level of detail remains much
less than that of the main character, so that
the background does not compete for attention
(Fig.25).

A Bit of Texture

As a final touch | choose the Artists’ Canvas
Paper from the Paper palette (Window > Library
Palette > Papers) and using the Round brush

at a large size, dab in a few textures in the
corners of the image, just to make it a bit more
interesting (Fig.26). As far as | can tell the
image is pretty much finished. However, | set

it aside for a few days so | can come back to

it with a fresh perspective before | do the final
submission. Time allowing, it's always a good
idea to take a break before formally declaring a
piece complete, otherwise there’s a danger of
getting “too close” to it and allowing familiarity to

mask its flaws.

Final Tweaks

When | look at it next | see that the rear hanging

edge of the troll's cloak appears too dark,
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drawing the eye into an unintentional — and
somewhat undesirable — focus. | zoom into the
shadowed areas and use the Artists’ Oils brush

to dab in a low value ochre color (Fig.27).

www.2dartistmag.com

page 75

©
Resize and Save

If you recall from Fig.08, the image dimensions
I've been working with are larger than the
specified print size. To obtain the print-spec
image | save a copy of the main image and
using Canvas > Resize, set the dimensions
accordingly. Because the large image is the
same aspect ratio as the intended smaller one it

isn’t distorted.

And that completes the picture. During this
tutorial Painter has been creating backups of the
file every time I've saved (Edit > Preferences >
General — tick Create Backup on Save), which

| do regularly. | also backed up my files onto a
separate disk at the end of every day | worked
on the project, using free backup software. For
the sake of a minute or two per day this can

save a lot of hassle!

I hope you found this tutorial useful and thanks

for reading.
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Simon Dominic

For more information please visit:
http://www.painterly.co.uk
Or contact them at:

si@painterly.co.uk
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Photoreal Fantasy - Griifin

Software used:

Introduction

http://www.google.com
http://www.ConceptArt.org

http://www.flickr.com
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Layer > Vector Mask > Reveal All
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Darren Yeow

http://stylusmonkey.carbonmade.com

darren@stylus-monkey.com

Griffin
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http://www.thegnomonworkshop.com/

“I'had a lot of iun
painting the hoy and
the monster. It was fun
to play around with
how the light interacted
with them and work out
Which colors I needed
to focus on.”
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Software used:
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Raiael Pereira do Nascimento

rafaelp.nascimento@hotmail.com
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£6 Digital Art Masters is in its
fifth edition now, and can easily
be considered one of the best
showcases of digital artwork
available today. The quality of the
artworks, the fine printing and the
valuable walkthroughs make this
book a must-have for any art lover
and for any CG artist, professional
or beginner. il

Alessandro Baldasseroni | www.eklettica.com

View the entire
Digital Art Masters: Volume 5 book online at
www.3dtotal.com/digitalartmasters_v5

Following on from the success of our first four books, we received yet another
overwhelming response to our call for submissions for Digital Art Masters: Volume 5. Once
again over 1,100 submissions made their way into the Digital Art Masters mailbox, proving
to us that the series is becoming ever more popular with not only our readers, but artists
around the world too!

From this massive number of incredible entries, the 3DTotal team began the difficult task of
choosing approximately 300 images to take through to the next round. To help in the task,
we enlisted the help of industry professionals Tim Warnock (matte painter), Till Nowak (3D
artist) and John Kearney and Chung Wong (videogame artists - VooFoo Studios) to be our
guest judges. These wonderful artists braved the headaches of a grueling judging process
and helped the 3DTotal team to select the 50 stunning images that appear in this year’s
fantastic line-up.

Hardback - 21.6cm x 27.9cm | 304 Full Colour Premium Paper Pages | ISBN: 978-0-240-52171-8

3DTOTAL.COM

Visit 3DTotal.com to see our full range Book products


http://www.3dtotal.com/digitalartmasters_v5/

concept art, digital & matte painting for only 275 (approx $3.78 - €2.93)

3DTotal presents the new issue of 3dcreative
magazine: a downloadable monthly magazine for

visit WMWW.3dcreativemag.com

to download the free ‘lite’ issue, the full issue, subscription
offers and to purchase back issues.
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Fdtotal.com

Is a resource website for the CG community;

amongst our growing number of products for CG

artists, we produce two monthly downloadable
PDF magazines — 2DArtist and 3DCreative.

We are based in the West Midlands, in the UK,
and our intention with our magazines is to make
each issue as full of great articles, images,

interviews and tutorials as possible. If you

would like more information on 3DTotal or our
magazines, or if you have a question for one our

team, please use the links below.

Contact Information

http://www.3dtotal.com
http://www.3dcreativemag.com

http://www.2dartistmag.com

Editor & Content Manager > Simon Morse

simon@3dtotal.com -
Lead Designer > Chris Perrins

chrisp@3dtotal.com

Marketing > Jo Hargreaves

jo@3dtotal.com

Partners . B -

If you have a CG community website and would
like to support 3DCreative and/or 2DAtrtist
magazine by showing our banners, please

contact Simon at the email address above
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